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CoLLIGO ENGAGE WINDOWS APP

Welcome to Colligo Engage Windows App, which offers full offline support, advanced metadata support,
and industry-leading sync and security capabilities, enabling organizations to embrace BYOD while
maintaining control of their corporate data.

Key Features
e Tag: Add automatic or customized metadata

¢ Sync: Make your SharePoint content available when offline
o Share: Replace attachments with links for easy collaboration

Benefits
e SyncSharePoint desktops & laptops for mobility & performance
e Enable productive offline access
o Edit files, lists, and metadata
o Easy-to-use, familiar desktop interface
e Drive enthusiastic SharePoint adoption
¢ Alleviate slow connectivity to SharePoint
¢ Replace network shares with SharePoint for document storage and collaboration

Platforms Supported

¢ SharePoint 2010, SharePoint Online (Office 365), and SharePoint 2013
¢ Outlook 2007, 2010, and 2013 (32-bit and 64-bit)
¢ Windows Vista, Windows 7, and Windows 8

NOTE: The screenshots in this document use Outlook 2010, SharePoint 2010, and Windows 7. Your user
interface may differ depending on your specific configuration.

Colligo Engage Windows App Interface

Colligo Engage Windows App consists of a core, stand-alone product interface and a Windows Explorer
extension. Depending on your preference, you can use one or both interfaces as the functionality is
essentially identical. le. You can perform an action in one interface and the other will reflect the change.

The stand-alone product is launched from the Start menu or from the system tray icon and displays as
follows:
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s =
@ Colligo Engage | = E £ |
File Site View Help
Site: [, <No Sites> - | :Sy:ndﬂronize... - | “'E_ View Sync Issues
Mew - | Upload - | Filter ~ View: - || |

|© Mo Synchronization Activity /d

v

The Windows Explorer extension displays as Colligo Colligo Engage Windows App under the Computer
node:

K95 ™ » Computer » Search Computer

Organize v Properties System properties Uninstall er change a program Map netwerk drive QOpen Control Panel

45¢ Favorites = 4 Hard Disk Drives (2)
B Desktop BOOTCAMP (C:) Macintosh HD (E:)
8 Downloads = | | =
&/ 463 GB free of 512 GB S 325 G free of 418 GE

23 Dropbox
% Recent Places 4 Devices with Removable Storage (1)

4 Ml Desktop @ DVD RW Drive (D)

4y Libraries
& |£] Decuments 4 Other (1)

b J’ Music f Colligo Engage
> @il New Library J System Folder
I» &5 Pictures
> B Videos

I | A Tessa MacKinnon

| 418 Computer

» &, BOOTCAMP (C:)
» <3 DVD RW Drive (D:)
I » Macintosh HD (E:)

1> ¥M Network

[ Control Panel
€] Recycle Bin

> i Flare

@;) Colligo Engage
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INSTALLING AND ACTIVATING COLLIGO ENGAGE WINDOWS APP

To install and activate Colligo Engage Windows App:
Double-click to open the Colligo Engage Windows App XX.zip file and extract the contents.
In the folder, double-click the folder that corresponds with your operating system:

a. x86: choose this option if you have a 32-bit operating system

b. x64: choose this option if you have a 64-bit operating system

1.
2.

N o v A

Double-click Setup.exe .
Follow the steps in the install wizard.

After installation is complete, enter your information to activate the software.
If you are unable to connect to the activation server, an error message displays:

© Colligo Engage

S

To complete your installation, please complete the fields below and click
Activate. Your privacy is important to us, and your personal information will
never be shared with third parties.

MNarme: David Jackson

Crganization: Firestarter

Email address: djackson@firestarter.cor‘r{

£3 Unable to connect to the activation server. Please try again later
or activate by email.

| Activate || Activate by Email || Exit

NOTE: The inability to connect could be due to firewall settings in your corporate network or a
dropped internet connection. If the connection issue is temporary, Colligo advises to attempt
activating at a later time before trying activation by email.

8. Click Activate by Email.
9. On the following screen, click Export Activation Request.

10. Save the ActivationRequest.txt file in your preferred location.

11. Attach this file to your email and send to activation@colligo.com.

Checking for Updates
To check if you are using the most current version of Colligo Engage Windows App, select the Help menu
and select Check for Updates.

The www.colligo.com site launches in your web browser. If there is a newer version available, click the
Download the latest version now link to install the newer build.

Updating Your License Key

To change your license key:
1. From the Help menu, select Install License Key.

10/9/2014

The Enter License Key dialog displays:
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Enter License Key

2. Enteryour license key and click OK.
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CONNECTING TO COLLIGO ENGAGE CONSOLE

If your solution includes Colligo Engage Console, the prompt displays when you are connected:

@ Colligo Engage Console g

Please enter your Colligo Engage credentials:

User name: | | |

Password:

Forgot Password?

[ CK ] [ Cancel

b A

Enter your User name and Password and click OK to connect.

If you have forgotten your password, click Forgot Password?

l Colligo Engage

A password reset request has been submitted. A temporary password has been
sent to your registered email address.
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ADDING SHAREPOINT SITES

Colligo Engage Windows App lets you connect to SharePoint sites through both the stand-alone interface

and the Windows Explorer extension.You can add a SharePoint list or library to Colligo Engage Windows
App in one of two ways:

¢ Using the Download New Site option
¢ Using the Connect to Engage option in Internet Explorer
Using the Download New Site Option (Stand-alone Interface)

To connect a site from the Colligo Engage Windows App stand-alone interface:
1. From the Site menu, choose Download New Site:

f‘ Colligo Engage
go Engag

File |Site [ View Help

Site:

Synchronize...

Synchronize All F2

Synchronize Pending Changes

-
L=
43 Synchronize Multiple Sites, .,
)
site| 2
=

pad ~ | Filter ~
Download New Site...

Manage Sites...

(? J Mo Synchronization Activity

The Download New Site dialog displays.
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» Download Mew Site ﬁ

Site: | <New Site> =l

URL: ||

Examples: htip:/fserver workspace
https: /fsecureserver fworkspace

—Server Authentication

Authentication Type: Auto-detect ;I

% Use default credentials
" Use the following credentials:

Uset narne: I

Passward: I

Download I Close |

3. Inthe Authentication Type drop-down menu, choose one of the following options:
e Auto-detect
¢ Windows Classic
¢ Windows Claim-based
e Form-Based
e ADFS2.0
o Office365
o Office365 by Prompt
4. Select either your default credentials, or supply other user-specific credentials.
5. Click Download.

The Select for Synchronization dialog displays the lists and libraries you have permissions for:

- B’
Select for Synchronization g

—Document Libraries and List:

= Synchronize all document libraries and lists
& Synchronize the following:

r @Announcement‘s

I [E calendar

[~ ElLinks

[ 43| Private Documents

[~ [ Product Lifecyde Dashboard
r _:T] Release Dashboard

- 13| Shared Documents

[~ [ Site Assets

[ [Eal Site Pages

[~ [ Tasks

Click the checkbox to enable or disable synchronization for
the specified list.

CheckAl | Uncheckal | Fiter... |

Synchronize I Cloze |
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6. Check the boxes beside the lists and libraries you want to synchronize; use the Check All or
Uncheck All buttons if needed.
7. Click Filter to select which folders and views you want to synchronize.

The Select Filters for Synchronization dialog displays:

Select Filters for Synchronization l&J

(" Disable Synchronization for this Document Library

(" synchronize Entire Document Library
* Only synchronize content based on the following filters:

Synchronized Folders

BLaf
3 Arakelyan et al v, Contoso LLC
" [ 1CE Co vs Contoso

N
| pem

Synchronized Views

(1] All Documents

J My Matters
J Recent Documents

| oK Cancel

o

7. Choose from the following options:
« Disable Synchronization for this Document Library: choose this option if you do not want the

document library to be available offline.
¢ Synchronize Entire Document Library: choose this option if want to synchronize everything in the

specified document library.
¢ Only synchronize content based on the following filters: choose this option if you want to selec-

tively choose what folders and views are synchronized. In the Synchronized Folders and Syn-
chronized Views sections, select a folder or view you want to synchronize and click Add to move it
to the Selected Folders/Views column.

8. Click OK.

9. Click Synchronize. The site displays in Colligo Colligo Engage Windows App.

Using the Download New Site Dialog (Windows Explorer Interface)

To connect a site from the Windows Explorer interface:
1. Right-click the Colligo Engage node and select Download New Site from the contextual menu:
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<®

Organize »

+ Computer » Colligo Engage »

»

4.7 Favorites m
Bl Desktop
& Downloads

%3 Dropbox
5l Recent Places

Colligo Intranet

4 M Computer
i &, BOOTCAMP (C:)
I 5 DVD RW Drive (D)
I = Macintosh HD (E:)

| @ Colligo En
2 9! Metwark Epad
» B Control Pan Open in new window
& Recycle Bin
Download Mew Site...
[ J4 Flare —

-

@ 1 item

The Download New Site dialog displays.

|

2. Choose your Authentication Type and use your default credentials, or user-specific credentials.
3. Click Download.

The site displays under the Colligo Engage node in Windows Explorer. However, the site’s lists and
libraries are not synchronized at this point and display as greyed out in Windows Explorer.

4. To synchronize a list or library, right-click it and select Enable Synchronization. To select filters for
synchronization, right-click a list or library and select Filter Synchronization.

Organize * = [l @

[ Pictures o Mame .
E Videos X

4 Custornized Reports
A Tessa MacKinnen

4} Form Templates
|Et Shared Dacuments | |
1 Site Ass Open
4 Site Pag

. Computer
£, BOOTCAMP (C)
) DVD RW Drive (D:)
= Macintesh HD (E)
@, Colligo Engage

Disable Synchronization
F astlelif y Eraple Synchronization
4 Test

4 Colligo Intranet Filter Synchronization...
c“ Metwark L Copy SharePoint URL
@ Control Panel 3
& Recycle Bin Default Metadata Values...

.. Flare

t Shared Documents

After you have enabled synchronization and set your filters, you need to start the synchronization
process. You can do this in one of two ways:

¢ Right-click the Colligo Engage icon in the system tray and choose Synchronize All:

10/9/2014 Copyright 2013 Colligo Networks, Inc. All rights reserved. Page 12 of 44

Not to be reproduced without permission. Learn more at www.colligo.com.



Colligo Engage Windows App

Open Colligo Engage

¥ | Automatic Synchronization
Synchronize All
View Synchronization Status

Cancel Synchronization

Exit

e From the Site menu in the stand-alone Colligo Engage interface, choose one of the following
options:
o Synchronize Multiple Sites: choose this option to synchronize more than one site. In the
Synchronize Multiple Sites dialog, check your preferred sites and click Synchronize.
o Synchronize All: choose this option to synchronize all sites
o Synchronize Pending Changes: choose this option to synchronize changes you have made

Using the Connect to Windows App Button

1. Navigate to a SharePoint List or Library in Internet Explorer.
2. Click the Connect to Windows App icon on the toolbar.

ﬁ = Eﬂ - [ gég * Page= Safety> Tools~ '@" {F_f L

Connect to Windows App

site Actions ~ B B BT

Colligo Intranet » Home

The Download New Site dialog displays.

» Download New Site M

Site: | <New Site> |

URL: ||

Examples:  http:ffserver fworkspace
https: //secureserver/workspace

Server Authentication

Authentication Type: |Aub:u-detect j

(¥ Use default credentials
(" Use the following credentials:

|
| Close
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In the Authentication Type drop-down menu, choose one of the following options:

Auto-detect

Windows Classic
Windows Claim-based
Form-Based

ADFS 2.0

Office365

Office365 by Prompt

4. Select either your default credentials, or supply other user-specific credentials.

5.

Click Download.

The Select for Synchronization dialog displays the lists and libraries you have permissions for:

ra

Select for Synchronization @

Document Libraries and Lists
" Synchronize all document libraries and lists

f* Synchronize the following:

™ &3 Announcements

I~ 78 calendar

I~ [ElLinks

™ [E&| Private Documents

I~ [ Product Lifecyde Dashboard
™ [ Release Dashboard

[ 3] Shared Documents

[ 3] Site Assets

[ 53] Site Pages

I~ [ Tasks

Click the checkbox to enable or disable synchronization for
the spedified list.

chekl | uncheckal |

Synchronize | Close |

6. Check the boxes beside the lists and libraries you want to synchronize; use the Check All or

7. Click Filter to select which folders and views you want to synchronize.
The Select Filters for Synchronization dialog displays:

10/9/

Uncheck All buttons if needed.
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Select Filters for Synchronization &

(" Disable Synchronization for this Document Library
(" synchronize Entire Document Library
{* Only synchronize content based on the following filters:

Synchronized Folders

=R
| Arakelyan et al v. Contoso LLC
i [CJ ICE Co vs Contoso

N
| pems

Synchronized Views

1] all Documents

J My Matters
j Recent Documents

| oK Cancel

8 ’

7. Choose from the following options:
o Disable Synchronization for this Document Library: choose this option if you do not want the
document library to be available offline.
¢ Synchronize Entire Document Library: choose this option if want to synchronize everything in the

specified document library.
¢ Only synchronize content based on the following filters: choose this option if you want to selec-

tively choose what folders and views are synchronized. In the Synchronized Folders and Syn-
chronized Views sections, select a folder or view you want to synchronize and click Add to move it
to the Selected Folders/Views column.

8. Click OK.

9. Click Synchronize. The site displays in Colligo Engage.

10/9/2014 Copyright 2013 Colligo Networks, Inc. All rights reserved. Page 15 of 44

Not to be reproduced without permission. Learn more at www.colligo.com.



Colligo Engage Windows App

Editing Lists and Libraries
After you have added your site and chosen which lists and libraries you want to sync, you may want to

go back at a later time and edit your choices.

You can edit your lists and libraries in one of two ways:
1. Right-click a list or library and select Enable Synchronization from the contextual menu.
2. Synchronize the site.

OR
1. From the Site menu, choose Download New Site.

The Download New Site dialog displays:
[ o Download MNew Site Iﬁ

Site: | <New Site» |

URL: ||

Examples:  http:/fserver fworkspace
https://secureserver fworkspace

Server Authentication

Authentication Type: |.-5.ub:|-detect j

% Use default credentials
(" Use the following credentials:

| Close

2. From the Site drop-down list, choose which site you want to configure.

The Synchronize Site dialog displays:
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';_-,, Synchronize Site

=

i H | Colligo Intranet hl

URL: Ihtt]:l:ﬂvs-spznlo

Examples: http:/fserver fworkspace
https: /{secureserver fworkspace

Synchronization Settings

© Only some lists will synchronize.
3 complete, 0 partial, 9 disabled

Configure... |

[~ perform full synchronization

Selecting this option will result in longer download times.

Synchronize I Close |

Selecting this option synchronizes all site content, induding users, views
and templates. If your permissions on the site have changed, you
should select this option to get all the content you now have access to.

),

Click Configure.

Click OK.
Click Synchronize.

ok w

Removing a Site

To remove a site from Colligo Engage Windows App:

1. From the Site menu, choose Manage Sites.
The Manage Sites dialog displays:

Manage Sites ﬁ

[ coligo Portal

Ihth:l:ﬂporiﬁl.colligo.com

Configure... I Remave... Close

2. Select the site you want to remove and click Remove.

OR

1. Select the site you want to remove in the Site field:

Colligo Engage Windows App

In the Configure Synchronization dialog, choose which Lists and Libraries you want to sync.
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©) Colligo Engage

File Site View Help

Site:l 4 Colligo Intranet - |=and1ronize... - | “'i

Documents Mew = | Upload | Filter »

= Shared Documents

2. From the Site menu, choose Remove Site:

r@ Caolligo Engage
File §|—te| View Help
Site: z Synchronize "Colligo Intranet™ Site... @y
- -"_‘_a Synchronize Multiple Sites...
-"_:':a Synchronize Al Fa
Dod _-'_% Synchronize Pending Changes | e
~{ iy Download Mew Site...
F Manage Sites. ..
- S_h Remaove Site...
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SETTING SYNCHRONIZATION OPTIONS

In Colligo Engage Windows App you can set your Synchronization options to your lists and libraries sync
automatically.However, you can also perform manual syncs as well.

Configuring Automatic Synchronization Options
1. From the View menu, select Options.

The Colligo Engage Options dialog displays:

r B

Storage

Storage location

|C: \Users\tmackinnon\AppData'Local\Coligalr  Browse...

General

[¥ Prompt for properties when adding documents

[ Use current Windows® appearance

Synchronization

Iv¥ Synchronize on startup

[v synchronize when list is viewed

Iv¥ Synchronize when list is modified

[v¥ Enable combined check-in and sync

[v Enable background synchronization

Background synchronization interval: IS‘D— minutes

Iv Automatically download lists to resalve Site Column values

Cancel | |

o »

2. Inthe General section, you can turn on the prompt to record properties about the document by
checking the Prompt for properties when adding documents box. You can override this setting for
specific lists/libraries when you are configuring default metadata; see Setting Default Metadata in
Briefcase.

3. Inthe Synchronization section, choose your preferred options:

¢ Synchronize on startup: choose this option if you want your lists and libraries to synchronize
every time the application starts

¢ Synchronize when list is viewed: choose this option if you want your lists and libraries to syn-
chronize every time you view a list or library

¢ Synchronize when list is modified: choose this option if you want your lists and libraries to syn-
chronize every time you modify a list or library

o Enable Combined check-in and sync: choose this option if you want to both check an item in and
sync it at the same time. If this option is not checked, the item remains checked out after the sync.

o Enable background synchronization: choose this option if you want to set the synchronization to
happen in the background on a time-specific basis, and enter your preferred time interval
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o Automatically download lists to resolve Site Column values: if you have lists that reference
other lists (look-ups), checking this option ensures the related referenced lists are also down-

loaded
NOTE: Depending on how your IT Administrator has configured the installation, this dialog may not be
accessible to you, or the synchronization options may be greyed out.

Synchronizing Sites Manually
After you have added your sites, you may want to synchronize them manually:

1. Click the Synchronize menu to display the options:

(©) Colligo Engage

File Site View Help

Site: [0y Colligo Intranet - gsinmronize... -

Synchronize "Colligo Intranet” Site...

Synchronize Multiple Sites. ..

Documents Synchronize Al Fg

Synchronize Pending Changes

Download Mew Site...

&

= Shared Documents

Lists

l@"_:::'i Last Synchronization: 10/1/2014 7:32:35 PM

L

2. Choose from the following:
« Synchronize Site: select this option to synchronize the site currently displayed
¢ Synchronize Multiple Sites: select this option to display all sites and choose which ones you want

to synchronize
¢ Synchronize All: select this option to synchronize all sites
¢ Synchronize Pending Changes: Select this option to synchronize any lists or libraries containing

changed content
The Synchronization In Progress dialog displays for any of the above options:
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s 5
Synchronization In Progress... [_thJ
Site List: Site: 4 Colligo Portal
% | Coligo Portal Server: é:';i http: ffportal. colligo.com

Synchronization Activity

Current List: E} Shared Documents

Status: Receiving... Office2010QA. doc (990 KB)
Received: 13 of 96 Sent: 0 of D

Working...

Cancel

[~ Close this window when synchronization completes

The Status field displays the name and size of the file being synchronized, as well as if the file is being
sent or received.

Viewing Pending Changes

When you are not connected to your SharePoint server, any changes and edits you make are listed in
the Pending Synchronization Changes dialog. You can review the changes you've made before
synchronizing them.

From the View menu, select View Pending Changes. The Pending Synchronization Changes dialog
displays any items that will be synchronized the next time you are connected to the network. You have
the option in this dialog to right-click an item and select discard if you want to revert the change.

Completing a Full Synchronization

Several of the synchronization dialogs have a Perform Full Synchronizationoption. This option means
that additional information is downloaded, including definitions for Sites, Lists, Views, and Content
Types, plus other site content that may not be retrieved during other standard sync processes.

Viewing and Resolving Synchronization Issues

When a sync error occurs, the item where the error occurred is highlighted and an error icon is overlaid
over the file type icon.

There is also a dialog that pops up from the system tray icon to indicate a sync error; you can click the
pop up for more information about the :

{4 Sync Error
A sync error has occurred.
Please click this message for more informaticon.

In addition, the View Sync Issues button changes color so it is more visible.

You can click the View Sync Issues button to display the Sync Issues pane:
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a
@ Colligo Engage

File Site  View Help

Site: n Firestarter Portal = | =Sznchronize..‘ | %VIEW Sync Issues (1)

Firestarter Portal > Marketing > Proposals

Marketing
Site Content New ~ | Upload ~ | Fiter ~ view: | All Documents ~ | [7]]
B Finance Name Modified Modified By Author  Related Company  Person/Group  Product  Published
E?“ TEE Bt workbook Ldex 10/4[20147:55AM  David Jackson _ RickR... Yes ]

[E} Manufacturing
4 Marketing
¥ Brochures
L% Campaigns
¥ Datasheets
4 ¥ Graphics
% Logos
¥ Market Research

@ Proposals Sync Issues

Et Strategy T

M Conflict

E Style Library

[ Campaign Tasks
EflEvent Schedule
[§E Staff Directory
[l vacation Tracking

Item

Workbook L.xdsx

Site List
@ Marketing

m Firestarter Portal

Folder
D fProposals

| »

(@) Last synchronization: 10/4/2014 7:55:46 AM A
)

The sync error displays the type of issue, the item name, site, list, and folder. You can use these columns

to sort your syncissues.

To resolve a syncissue, right click the line item and choose View Conflict.

The Resolve Synchronization Conflict screen displays:

Server Version

Opticns

Options

Content Type: | Document

Content Type: | Document

-Properh'ﬁ

-Properties

[t 13

[

o

DJackson -

3

[ttt 18

[

4

Dlackson -

3

Last Update

Last Update

Editor:  David Jackson
Modified: 3/12/2014 1:56:08 FM

Version: 1.7

Editor:  Jerry McKenzie
Modified: 3/12/2014 1:55:51 PM

Version: 1.8

You can choose to merge the two versions, or choose either the local or server version to resolve the

conflict.
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VIEWING, EDITING, AND CREATING NEW CONTENT IN COLLIGO ENGAGE WINDOWS
APP (STAND-ALONE INTERFACE)

After you have added your sites and synchronized your lists and libraries, the content is available offline
(when you are not connected to your SharePoint network). You can now view and edit SharePoint items,
create new content, check items in and out of SharePoint, as well as rename and delete items, from the
Colligo Engage Windows App interface.

7
f Colligo Engage
File Site View Help
Site: |, Firestarter Portal = e Synchronize... -
— Firestarter Portal = Marketing
| Marketing
Site Content Mew - | Upload ~ | Filter -
= Name Madified Modified By Author
E‘j & Brochures 9/19/2013 9:33 AM Mary White
& & Campaigns 9/19/2013 9:33 AM Mary White
M & : Marketi Et Datasheets 9/19/2013 9:33 AM Mary White
B Brachures CF Graphics 9/19/2013 10:35AM  David Jackson
% Campaigns Et Market Research  9/19/2013 9:37 AM Mary White
[} Datashests Et Propasals 9/19/2013 9:38 AM Mary White
4 [F Graphics % strateay 9/19/2013%:37AM  Mary White
¥ Logos
[ Market Research
% Proposals
¥ strategy

The Tree View in the stand-alone interface allows you to view content more dynamically and to move and
copy content between folders in the same SharePoint site using drag-and-drop. You can change the view
by enabling or disabling the Tree View option in the View menu:

-
f Caolligo Engage
Ele Site | View | Help
site: [} C \'ﬁ?_ﬂ View Sync Issues 4
Shared Documents
View Pending Changes... Tall ments
Document ¥ show Filter Choices with the team by adding it to this docu
p 4 Filter =
Refresh F5 Modified
" SharedD) o tons... 10/1/2014 7:46 PM
- 122044 Ben... 9/26/2014 10:22 AM
Tree View
S0ct2013.p 014 10:28
EE— ACME Quote-Word 2003.... 5(7/20146:31PM

NOTE: you cannot enable or disable synchronization of document libraries or lists while Tree View is
enabled. If you want to do this, you must turn off Tree View and work in List View.

NOTE: If the Tree View option is not available to you, it has been disabled by your IT Administrator.

The following icons are overlaid on file type icons in the sync pane to indicate the following item statuses:
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e Syncerror:

e Syncpending: @

e Checked out by me: @

e Checked out by another user:

e Declared Record:

Viewing Content

To view an item in a library/folder, double-click it. It opens in the program native to the item type. You
can then edit the item if preferred.

If Tree View is enabled, you can expand and contract folders in the left pane to navigate to the
SharePoint location you are looking for. The folder that is highlighted in the Tree View indicates the
SharePoint location you are currently are viewing.

s <
f, Colligo Engage = | B
File Site View Help
Site: |1y Firestarter Portal - z Synchronize... -
= Firestarter Portal > Marketing > Graphics
| = Marketing
Site Content 1| Mew - | Upload = | Filter = View: All Documents - | 1]
’:5 Mame Modified Madified By Author  Related Company  PersonfGroup  Product  PublisH
% Et Logos 9/19/2013 10:36 AM  David Jackson
’:j |k firestarter.jpa 9/19/2013 10:40 AM  David Jackson
a4 [ Marksting | firestarter_blue.... 3/5/2014 2:19PM David Jackson Yes
[$ Brochures || firestarter_blue... 9/13/2013 10:40 AM  David Jackson
[ Campaigns |k firestarter_purp... 9/13/2013 10:40 AM  David Jackson
[} Datashests |i=| firestarter_purp... 9/15/2013 10:40 AM  David Jackson
I m | firestarter_sm.jpg  9/19/2013 10:40 AM  David Jackson
[ Market Research |i=| firestarter_sm_... 9/13/2013 10:40AM  David Jackson
% Proposals 1 Helen Jones_09... 10/9/2013 11:29 AM  David Jackson Excite
Et Ctrategy
=)
m L
i
CE| MIE | »
@ Last Synchronization: 10/4/2014 7:58:04 AM
h J

Viewing Item Version History

If a library has versioning enabled, you can view an item's version history by choosing the Version
History option in the right-click contextual menu:
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-

@ Colligo Engage

File Site View Help

site: [T Firestarter Portal ~ | 2 Synchronize... - | &Y, View Sync Issues
| —= Firestarter Portal > Marketing = Graphics
[3 Marketing
Site Content Mew - | Upload ~ | Filter + Vi
&} Finance MName Modified Modified By Author  Related Company  Person/Group
Form Templates
E'T b % Logos 9/19/2013 10:36 AM  David Jackson
) ) % firestarter.j = Demeid oocho.
[E} Manufacturing cy e |52 Edit Properties...
4 [T Marketing 5 firestarter_blue =
[ Braochures [ firestarter_blue| f=] Open with Windows Photo Viewer
[} Campaigns frestarter_purB = Egit with Paint
[} Datasheets [&=] firestarter_purp
i [} Graphics [=] firestarter_sm.j Copy
% Market Research =] firestarter_sm_ Paste
¥ Proposals =1 Helen Jones_09 Lh Check In
¥ strategy

@j Discard Check Out

||Ej Version History

Send As Link

Send As Attachment

[l Campaign
— @, Copy SharePoint URL

EE ent

CE| @, Copy SharePoint Doc ID URL
] vacation Tracking e
¥ Delete
Create Shortout

| @ Last Synchron

NOTE: this feature is enabled only when you are connected to your SharePoint server. If you are offline,
the option is greyed out.

The Version History window displays:

No Maodified Meodified By Size Comments
0.4 2014-09-129:45 Rick Ramsay 18 KB
03 2014-09-10 6:02 Rick Ramsay 18 KB
02 2014-09-105:12 Rick Ramsay 35 KB
01 2014-08-13 529 Rick Ramsay 35 KB

Click on a version number to open the SharePoint version of the item.

Emailing a Link or an Attachment

You can email a link to a SharePoint item or you can send the item as a physical attachment.
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Choose either Send As Link or Send As Attachment from the contextual menu:

-
@ Colligo Engage

File Site View Help

site: |\, Firestarter Portal = | zsim:hronize... - | &%, view Sync Issues

Firestarter Portal > Marketing > Graphics
[ = ; Marketing
Site Content Mew ~ | Upload - | Filter -
[E} Finance Name Modified Modified By Author  Related Comp
%___' B % Loges 9/18/2013 10:36 AM  David Jackson
L_j- L [*% firestarter.jpg 9/13/90112 10:40 &M Navid ladksan
PRE Mar‘rcetmg ) 5] firestarter_blu 52 EditProperties...
¥ Brochures =/ firestarter_blu =] Open with Windows Photo Viewer
A w firestarter_pu
L¥ Campaigns = @l Edit with Paint
% Datashests |i=!| firestarter_pu
I % Graphics = firestarter_sm Copy
% Markst Research |=| firestarter_sm Paste
¥ Proposals 1“1 Helen Jones_n
[ strategy Ly CheckIn
(B sales | Discard Check Out
% - EE] Veersion History
(B sodia Send As Link
s Send As Attachment
_ﬁ] C. =
i [ & Copy SharePoint URL
CE| @ Copy SharePoint Doc ID URL
j.:-:'- e Rename
¥ Delete
Create Shortout

Choosing one of these options launches your mail client with the link or physical attachment already
present.

Creating a Shortcut to an Item

You can create a shortcut to any SharePoint item from the contextual menu:
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-
@ Colligo Engage

Eile Site Wiew Help

Site: |, Firestarter Portal = | :Szndvonize... - | &

Firestarter Portal = Marketing > Graphics

= -
| L=l Marketing
Site Content Mew - | Upload - | Filter +
'__‘—1 Mame Modified Modified By Author  Related Company
L_-ll Et Logos 9/19/2013 10:36 AM  David Jackson
% [*Z firestarter.jpg G184N17 A0-4N AM _ Mawid Jadkenn
4 [ Marketing | firestarter_blue.... 3 £ EditPropertes...
¥ Brochures | firestarter_blue... 9|27 open with Windows Phato Viewer
; e firestarter_purp... 9|

L¥ Campaigns = PUP- 2 T Edit with Paint

[ Datashests |i=| firestarter_purp... 9
I [k Graphics |=] frestarter_sm.jpg 9 Copy

¥ Market Research [=| firestarter_sm_... 9

¥ Proposals -1 Helen Jones_09... 1

[8 Strategy l-h Check In
& lei] Discard Check Out
E‘; .Sj Version History
= Send As Link
& Send As Attachment
m
G| @ Copy SharePoint URL
HE ., Copy SharePoint Doc ID URL
4

Rename
2 Delete
I Create Shortout I

The default location for the shortcut is your desktop.

Editing Content

To edit an item in a library/folder, double-click it to open the item in its native program. Edit the item as
preferred, save it, and close it.

The changes are uploaded to SharePoint the next time the list/library is synchronized.

NOTE: If another user has opened the document, edited it, and uploaded it to SharePoint, and you try to
upload the same document with your changes, the following dialog displays:
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Document

StratMLFAQ20091027.doc
% Microsoft Word 97 - 2003 Document
=l 74.0KB (75,776 bytes)

@ Microsoft Word

Folder

Server Version

Document

StratMLFAQ20091027.doc
% Microsoft Word 97 - 2003 Document
=l 74.0KB (75,776 bytes)

@ Microsoft Word

Falder

Colligo Engage Windows App

=X

EX

Properties

Content Type: | Demo Document

Properties

Content Type:

Demo Document

Name =
StratMLFAQ20091027.doc

Title
StratMLFAQ20091027.doc

Correspondence List
Audio Visual

Market Sector

Defence + Justice + Custodial

Name =

StratMLFAQ20091027.doc

Title

StratMLFAQ20091027.doc

Correspondence List
Audio Visual

Market Sector

Defence + Justice + Custodial

Revert

Apply |

Last Update
Editor: Tessa Mackinnon
Modified: 07/09/2011 5:12:31FM

Apply

| Rewvert

Last Update
Editor: Tessa Mackinnon

Modified: 07/09/2011 5:13:25FM

You can click Open to view the edits in each version, and then click one of the following options:

e Choose Local Version: if you choose this option, the version on your local machine overwrites the
current version on SharePoint
o Merge Versions: If you choose this option, a wizard displays and walks you through a process to
choose the changes you want to keep or discard
« Choose Server Version: if you choose this option, the version on SharePoint does not change;

you are effectively discarding your version

Editing Item Properties

To edit the properties of an item:

1. Right-click the item and choose Edit Properties:
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=
{©) Colligo Engage
File Site Wew Help
Site: |, Firestarter Portal = | :Sinthronize... - | &
—] Firestarter Portal > Marketing > Graphics
| =N Marketing
Site Content Mew ~ | Upload ~ | Filter ~
L—j Mame Modified Modified By Author  Related Company
5 Et Logos 9/19/2013 10:36 AM  David Jackson
E i 9/16/7012 10-40 AM__Niawid ladkenn
4 [ Marketing | firestarter bl C# EditProperties...
% Brochures li=! firestarter_bli 27 open with Windows Photo Viewer
; u] firestarter_py o
¥ Campaigns = P&l edit with Paint
[F Datashests = firestarter_py
v [} Graphics [=] firestarter_sm Copy
[F Market Research || (=) frestarter_sn
¥ Proposals =1 Helen Jones_
OF strateqy g CheckIn
=) £ Discard Check Out
g _Sj Version History
= Send As Link
(=) send As Attachment
[
| @ Copy SharePoint URL
LIE 8 Copy SharePoint Doc ID URL
g
Rename
¥ Delete
Create Shortout |_
N

The Edit Properties dialog displays.

2. Edit as preferred and click Close.

The changes are uploaded to SharePoint the next time the list/library is synchronized.

Checking Items In or Out

To check an item in or out, right-click it and choose Check Out/In. The Check In option only displays if
you have previously checked the item out.

Once you have checked an item out, the Check Out icon is overlaid on top of the document type icon, so
users can see that the item is being edited:

After you have checked the item out, you can open it, edit it, and then check it back in to the list/library.
The changes are uploaded to SharePoint the next time the list/library is synchronized.

NOTE: If you try to check out an item that has been modified in SharePoint and not synchronized, the
following message displays:
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Check Out Ttem(s) S5
The operation completed with errors,
Item Message Description
% Colligo Style Sheet.docx Version Mismatch The version of the file on the server is different from the l...

Cloze

Close the dialog, synchronize the site so you have the most up-to-date version of the document, and
then perform the Check Out operation again.

To avoid the above conflict, select the combined check-in and sync option as described in Setting
Synchronization Options.

Renaming Items
To rename an item:

1. Right-click it and select Rename.
2. Theitem name becomes editable. Edit as preferred, and press Enter to complete the change.

The change is reflected in SharePoint the next time the list/library is synchronized.

NOTE: you cannot rename an item if it is checked out by another user. If the item is checked out, a red
Check Out icon displays on the item.

Deleting Items
To delete an item, right-click it and select Delete.
The change is reflected in SharePoint the next time the list/library is synchronized.

NOTE: you cannot delete an item if it is checked out by another user. If the item is checked out, a red
check-out icon displays on the item.

Creating New Content

In addition to editing existing content in SharePoint, you can also add new content to your synchronized
lists and libraries.

You can add items to Colligo Engage Windows App in one of the following ways:

o Create new documents from the Colligo Engage Windows App menus
¢ Upload existing content
e Drag-and-drop or copy-and-paste content

Adding a New Document to a List/Library

To add a new document to a list or library:

1. Select the list or library you want to add the document to and click the New menu and select your
preferred document type from the drop-down list:
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.
@ Colligo Engage
File Site View Help
Site: |1y Firestarter Portal - | : Synchronize.., ~ | o
| = Firestarter Portal > Marketing > Graphics
e Marketing
Site Content New - || Upload ~ | Filter -
,:j Document Modified Modified By Author  Related Compg
% Image 9/19/2013 10:36 AM  David Jackson
,:j Ema 9/19/2013 10:40 AM  David Jackson
4 (B Marketing 3/5/2014 2:19PM David Jackson
C¢ Brochures [ Folder 9/19/2013 10:40 AM  David Jackson
O Campaigns E firestarter_purp... 9/19/2013 10:40 AM  David Jackson
CF Datashests |=| firestarter_purp... 9/19/2013 10:40 AM  David Jackson
I [} Graphics || firestarter_sm.jpg  9/19/2013 10:40 AM  David Jackson
% Market Research |=| firestarter_sm_... 9/19/2013 10:40 AM  David Jackson
Prapasals -l Helen Jones_09... : avid Jackson
posa " Helen J 09... 10/9/2013 11:29AM  David Jacks
¥ strategy
=

The Create New Document dialog displays:

-
] Create New Document

===

Site Templates | Other

]

template

Mew Document

Please enter a name for this new document:

[ Create

]

| concel |

2. Choose your document type from the Site Templates tab or the Other tab.
3. Enter a name for the document, and click Create.

The Edit Properties dialog displays. This is where you can record information about the document
that you are adding to SharePoint.

4. Edit the Edit Properties dialog as preferred.
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@ Edit Properties EIM
Options
Content Type: | Document -
.Prnpertias
Mame Value
« Name New Document decx
Title
Author
Related Company
Person/Group 8,
Product (44 ]
Published
QK | Cancel
\ J

5. Click Create. The document is added to the SharePoint location.

Using the Upload Documents Dialog
To add an existing document to a list or library:

1. With thelist or library you want to add the document to selected, click the Upload menu, and
choose Upload Documents:

-
@ Colligo Engage
Ele Site Wiew Help
Site: |, Firestarter Portal = | =Smd1ronize... - | &
= Firestarter Portal = Marketing > Graphics
[ =2 . Marketing
Site Content New | Upload ~ | Filter =~
L_j Finance Mame |lj Upload Documents |i Modified By Author  Related
%_'_' HILESLL S Lt Loges 9/18/2013 10:36 AM  David Jacksan
,:5' e F frestarterjpg  9/19/2013 10:40 AM  David Jackson
. M; rketlng ) |51 firestarter_blue.... 3/5/2014 2:19PM David Jackson
[# Brachures || firestarter_blue... 9/19/2013 10:40 AM  David Jackson
% Campaigns | firestarter_purp... 9/19/2013 10:40 AM  David Jackson
[§ Datashasts = firestarter_purp... 9/19/2013 10:40 AM  David Jackson
4 [} Graphics |e= firestarter_sm.jpg  9/19/2013 10:40 AM  David Jackson
F Logos = firestarter_sm_... 9/19/2013 10:40 AM  David Jackson
¥ Market Research <1 Helen Jones_09... 10/9/2013 11:29 AM  David Jackson
¥ Proposals
[} strategy
=1 -

The Upload Documents dialog displays.
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2. Browse to the document that you want to upload, and click Open. To select more than one doc-
ument, use Ctrl + click.
3. The Edit Properties dialog displays. Edit as preferred and click Create.

The document is added to the SharePoint location. If you have selected more than one document,
any properties you assign apply to all items.

Dragging-and-Dropping Content
You can drag-and-drop one or more files or complete folder structures into Colligo Engage Windows App
from your desktop or from other directory locations.

1. Drag-and-drop your preferred files or folders from your desktop or another directory to your pre-
ferred SharePoint location in Colligo Engage Windows App .

2. The Edit Properties dialog displays. Edit as preferred and click Create. The file or folder is added to
the SharePoint location. If you have selected more than one document or a folder, any properties
you assign apply to all items.

You can also drag-and-drop content from the Windows Explorer extension to the stand-alone interface.
This action is a copy and paste; cut is not supported in this feature.

Moving or Copying Content within SharePoint

You can move or copy content from one location in SharePoint to another location, through the Colligo
Engage Windows App interface.

NOTE: This feature is disabled by default. Contact your IT Administrator.
1. Select one or more files in a library or folder, and drag-and-drop it to another folder.

The Edit Properties dialog displays.

2. Edit as preferred and click Create.
The following dialog displays:

'd h
() Move ar Copy I,&J

L‘ ‘Warning:

Afiles version history, last modified time, and creator information are deleted during the
Move or Copy action. The Move action deletes the original file(s).

Move | Copy |

L o

3. Click Move or Copy. Note that no version history, timestamps, or original author information is pre-
served in either the Move or Copy action. If you choose to move an item, the original file is deleted.
In addition, any metadata associated with the original file will not be preserved and you will need to
enter new metadata for the item.
NOTE: You cannot move an item that is checked out by another user. If you attempt to do this, the
following error message displays:
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S

over an item to see the details.

There were errors validating the move operation. Hover your mouse

Copy

Cancel

Colligo Engage Windows App

If you hover your mouse over the item, a message displays telling you who has the item checked out.
That user needs to check the item back in before you can move the item.

You can also drag-and-drop content from the Windows Explorer extension to the stand-alone interface.
This action is a copy and paste; move is not supported in this feature.

Searching Content

If the search feature is enabled, you can enter a term in the search field and it will search the entire
SharePoint site that you are currently viewing:

(l’ Collige Engage

=RREn

File Site View Help
Site: [l Firestarter Portal

=
| -

- esinchronize... -

Firestarter Portal > Sales

Sales

Search on SharePoint: /

Documents

®= Finance

= Sales

Mew = | Upload « | Filter =

view: | All Documents

Mame

Et Contracts
Et Presentations
Et Pricelists

Et Reports

Et Sales Tools

BN TR )

ARC-EAD

Modified

9192013 9:33 AM
9/19/2013 9:33 AM
9/19/2013 9:33 AM
9/19/2013 9:33 AM
5/19/2013 9:33 AM

AAMEIINAD 44,97 AR

Modified By
Helen Jones
Helen Jones
Helen Jones
Helen Jones

Helen Jones

Prowidd 1=l

When you enter a term and press Enter, or click the magnifying glass icon, your web browser launches
and the search results for the site display.

Because this search yields results from your SharePoint server, this feature is only supported when you
are connected to your server. When you are offline, this function will not work.
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VIEWING, EDITING, AND CREATING NEW CONTENT IN COLLIGO ENGAGE WINDOWS
Aprp (WINDOWS EXPLORER INTERFACE)

After you have added your sites and synchronized your lists and libraries, the content is available offline
(when you are not connected to your SharePoint network). You can now view and edit SharePoint items,
create new content, check items in and out of SharePoint, as well as rename and delete items, from the

Colligo Engage Windows App interface.

e

@Qvﬁt <« Colligo Engage » | Firestarter Portal | » | Marketing »

v|¢’|

Search Marketing
Search Marketing

Organize «
= Libraries
3 Documents
J‘. Music
il New Library
= Pictures
B videos
2 Tessa MacKinnon
1% Computer
&, BOOTCAMP (C)
&5 DVD RW Drive (D:)
—a Macintosh HD (Ez)
(F, Colligo Engage
‘?j Metwork
[543 Control Panel
£ Recycle Bin
. Flare

t 7 items

I Brochures

Datasheets

I Market Research

Strategy

m

Campaigns

L |
t Graphics
|

Proposals

@l\_—/"| o ¥ Computer » Colligo Engage » Colligo Intranet »

aearch Lol

v|¢,|

Organize +

Pl Desktop
4 Libraries
3 Documents
J’. Music
Gl Mew Library
[e=| Pictures
H videos
@_’:} Colligo Engage
4 Colligo Intranet
. Firestarter Portal
vj MNetwaork
[E8 Contral Panel
7 items

ad

Customize
d Reports

Test

Form
Templates

1

Shared
Documents

Site Assets
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The following icons are overlaid on file type icons to indicate the following item statuses:

W,
Sync error:

Sync pending:

Checked out by me:

Checked out by another user:

Declared Record:

Viewing Content

To view an item in a library/folder, double-click it. It opens in the program native to the item type. You
can then edit the item if preferred.

Emailing a Link or an Attachment

You can email a link to a SharePoint item or you can send the item as a physical attachment.

Choose either Send As Link or Send As Attachment from the contextual menu:

=)

Organize +

Bl Desktop
4 Libraries
@ Documents
‘J? Music
gﬂ MNew Library
(5] Pictures
B2 Videos
A Tessa MacKinnon
. Computer
£, BOOTCAMP (C)
5 DVD RW Drive (D)
= Macintesh HD (E:)
f; Colligo Engage
» Colligo Intranet
» Firestarter Portal
G"; MNetwork
[ Contral Panel
==l Workbookl xlsx

m

Creating a Shortcut to an Item

IR = Freswter Pl + Marking » Proposts =] 5

e

Edit Properties...

Open with Microsoft Excel
Edit with Microsoft Excel

Check Out

Copy SharePoint URL
Copy SharePoint Doc ID URL

Copy
Paste

Send As Link
Send As Attachment

Create Shortcut

Rename

Delete

arch Proposals pe |
=)

You can create a shortcut to any SharePoint item from the contextual menu:
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=)

" & < Firestarter Portal » Marketing » Proposals - |. Search Proposals L

Organize

Ml Desktop Wol ; ;

— e = Edit Properties...

= Libraries
@ Documents Open with Microsoft Excel
& Music I Edit with Microsoft Excel

Mew Lib

] New Library Check Out
[ Pictures
B# Videos Copy SharePoint URL

A Tessa MacKinnon Copy SharePoint Doc ID URL

m

% Com puter

Copy
£, BOOTCAMP (C1) Dacte
= DVD RW Drive (D:)
= Macintosh HD (E:) Send As Link
(f;' Colligo Engage Send As Attachment
& Colligo Intranet | Create Shortcut
»» Firestarter Portal
Gh Metwork Rename
[E8 Control Panel % Delete

==L Workbooklxlsx

Editing Content

To edit an item in a library/folder, double-click it to open the item in its native program. Edit the item as
preferred, save it, and close it.

The changes are uploaded to SharePoint the next time the list/library is synchronized.

NOTE: If another user has opened the document, edited it, and uploaded it to SharePoint, and you try to
upload the same document with your changes, the following dialog displays:
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Document

StratMLFAQ20091027.doc
% Microsoft Word 97 - 2003 Document
=l 74.0KB (75,776 bytes)

@ Microsoft Word

Folder

Server Version

Document

StratMLFAQ20091027.doc
% Microsoft Word 97 - 2003 Document
=l 74.0KB (75,776 bytes)

@ Microsoft Word

Falder

Colligo Engage Windows App

=X

EX

Properties

Content Type: | Demo Document

Properties

Content Type:

Demo Document

Name =
StratMLFAQ20091027.doc

Title
StratMLFAQ20091027.doc

Correspondence List
Audio Visual

Market Sector

Defence + Justice + Custodial

Name =

StratMLFAQ20091027.doc

Title
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Apply
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You can click Open to view the edits in each version, and then click one of the following options:

e Choose Local Version: if you choose this option, the version on your local machine overwrites the
current version on SharePoint
o Merge Versions: If you choose this option, a wizard displays and walks you through a process to
choose the changes you want to keep or discard
« Choose Server Version: if you choose this option, the version on SharePoint does not change;

you are effectively discarding your version

Editing Item Properties

To edit the properties of an item:

1. Right-click the item and choose Edit Properties:
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Create Shortcut

Rename
Delete

The Edit Properties dialog displays.

2. Edit as preferred and click Close.

The changes are uploaded to SharePoint the next time the list/library is synchronized.

Checking Items In or Out

To check an item in or out, right-click it and choose Check Out/In. The Check In option only displays if
you have previously checked the item out.

Once you have checked an item out, the Check Out icon is overlaid on top of the document type icon, so
users can see that the item is being edited:

After you have checked the item out, you can open it, edit it, and then check it back in to the list/library.
The changes are uploaded to SharePoint the next time the list/library is synchronized.

NOTE: If you try to check out an item that has been modified in SharePoint and not synchronized, the

following message displays:

Check Out Itemis)

===

The operation completed with errors.

¥ Colligo Style Sheet.docx

Item Message

Version Mismatch

Description

The version of the file on the server is different from the l...
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Close the dialog, synchronize the site so you have the most up-to-date version of the document, and
then perform the Check Out operation again.

To avoid the above conflict, select the combined check-in and sync option as described in Setting
Synchronization Options.

Renaming Items
To rename an item:

1. Right-click it and select Rename.
2. Theitem name becomes editable. Edit as preferred, and press Enter to complete the change.

The change is reflected in SharePoint the next time the list/library is synchronized.

NOTE: you cannot rename an item if it is checked out by another user. If the item is checked out, a red
Check Out icon displays on the item.

Deleting Items

To delete an item, right-click it and select Delete.
The change is reflected in SharePoint the next time the list/library is synchronized.

NOTE: you cannot delete an item if it is checked out by another user. If the item is checked out, a red
check-out icon displays on the item.

Creating New Content

In addition to editing existing content in SharePoint, you can also add new content to your synchronized
lists and libraries.

You can add items in the Windows Explorer extension of Colligo Engage Windows App in one of the
following ways:

o Add a new document from within the Colligo Engage Windows App Windows Explorer interface
Upload existing content

Drag-and-drop or copy-and-paste content

Use the File > Save As command

Adding a New Document to a List/Library
From within Windows Explorer, you can create and add a new document to a SharePoint location:
1. From the File menu, choose New > New Document:
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NOTE: if you cannot see the File menu, press Alt key to display it.

m

The Create New Document dialog displays:

' ™y
] Create New Document u

Site Templates | Other

template

Please enter a name for this new document:

Mew Document

E Create ] ’ Cancel ]

2. Choose your document type from the Site Templates tab or the Other tab.
3. Enter a name for the document, and click Create.

The Edit Properties dialog displays.
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Content Type: | Document -

Properties
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« Name New Document docx

Title

0K | Cancel |

o A

4. This dialog is where you can record information about the document. Edit as preferred.
5. Click OK. The document is added to the SharePoint location.

Using the Upload Documents Dialog

From within Windows Explorer, you can upload existing documents to your preferred SharePoint
location:

1. From the File menu, choose Upload Documents:
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NOTE: if you cannot see the File menu, press the Alt key to display it.

The Upload Documents dialog displays.

2. Browse to the document that you want to upload, and click Open. To select more than one doc-

ument, use Ctrl + click.
3. The Edit Properties dialog displays. Edit as preferred and click OK.

The document is added to the SharePoint location. If you have selected more than one document,
any properties you assign apply to all items.

Dragging-and-Dropping Content
You can drag-and-drop one or more files or complete folder structures into File Manager from your
desktop or from other directory locations:

1. Drag-and-drop your preferred files or folders from your desktop or another directory to your pre-
ferred SharePoint location in the Windows Explorer extension of Colligo Engage Windows App.
2. The Edit Properties dialog displays. Edit as preferred and click OK.

The file or folder is added to the SharePoint location. If you have selected more than one document
or a folder, any properties you assign apply to all items.

You can also drag-and-drop content from the Windows Explorer extension to the stand-alone interface.
This action is a copy and paste; cut is not supported in this feature.

Using the File Save As Command

You can use the File > Save As command from integrated programs to save directly into any of the
SharePoint lists or libraries you have connected to Contributor File Manager:
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In your open document, select File > Save As.
In the Save As dialog, navigate to your SharePoint location, edit the file name as needed, and click
Open:

- Y
GE] save As M
@I\:jvlﬁi » Computer » Colligo Engage » Firestarter Portal » Marketing » - |4-, | | Search Marketing pe |

Organize * == - (7]
> &3 DVD RW Drive (D) B -
> Macintosh HD (E:) I Brochures I Campaigns
4 (©) Colligo Engage
» iy Colligo Intranet )
[T} Firestarter Portal t Datasheets t Graphics )
E__H Finance 3
E} EorniS e Market Research Proposals
By
E__H Manufacturing
Da Marketing I Strategy B
= W o o
File name: Docl -
Save as type: ’Word Document A
Authors: Tessa MacKinnon Tags: Add atag Title: Add a title
[ Save Thumbnail
=« Hide Folders Tools ~ [ Save ] ’ Cancel
3. The Edit Properties dialog displays. Edit as preferred and click Close.
The document is added to the SharePoint location.
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